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Warranty 

All products manufactured by ICP DAS are under warranty regarding 

defective materials for a period of one year, beginning from the date 

of delivery to the original purchaser. 

Warning 

ICP DAS assumes no liability for any damage resulting from the use of 

this product.ICP DAS reserves the right to change this manual at any 

time without notice. The information furnished by ICP DAS is believed 

to be accurate and reliable. However, no responsibility is assumed by 

ICP DAS for its use, not for any infringements of patents or other 

rights of third parties resulting from its use. 

Copyright 

Copyright @ 2014 by ICP DAS Co., Ltd. All rights are reserved. 

Trademark 

The names used for identification only may be registered trademarks 

of their respective companies. 

 

Contact US 

 

If you have any problem, please feel free to contact us. 

You can count on us for quick response. 

 

   Email: service@icpdas.com 

 

 

 

mailto:service@icpdas.com
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1.  Introduction 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

WinPAC-5000 Series is the new generation PAC (Programmable Automation 

Controller). It is equipped with a PXA270 CPU (520 MHz) running a Windows 

CE.NET 5.0 operating system, various connectivity (VGA, USB, Ethernet, 

RS-232/485) and I/O expansion bus. 

The WinPAC-5000 series has many advantages, including hard real-time capability, 

small core size, and fast boot speed, interrupt handling at a deeper level, achievable 

deterministic control and low cost. Using Windows CE.NET 5.0 gives it the ability to 

run PC-based control software such as Visual Basic.NET, Visual C#, Embedded 

Visual C++, SCADA software, SoftPLC. It gives users all of the best features of both 

traditional PLCs and Windows capable PCs. 

For hardware expansion, it also supports an I/O expansion bus. The I/O expansion 

bus can be used to implement various I/O functions such as D/I, D/O, A/D, D/A, 

Timer/Counter, UART, and other I/O functions. Nearly all kinds of I/O functions can 

be implemented by this bus. But the bus can support only one board. There are 

more than 10 boards available for WinPAC-5000 series which users can choose one 

of them to expand hardware features. 
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1.1.  WinPAC-5000 Family 

The WinPAC-5000 family is divided into two main types according to Audio port.  

▪ WP-5141 (without Audio port) 

▪ WP-5141-OD (with Audio port) 

▪ WP-5151 (without Audio port) 

▪ WP-5151-OD (with Audio port) 

 

 

1.1.1.  WinPAC-5000 Naming Convention 

As you examine this manual, you„ll notice there are many different models available. 

Sometimes it is difficult to remember the specifications for any given model. 

However, if you take a few minutes to understand the module naming conventions, it 

may save you some time and confusion. The figure below shows how the module 

naming conventions work for each WinPAC-5000 model. 
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1.1.2.  WinPAC-5000 Comparison 

The following table shows the comparison in all the features of WinPAC-5000 family. 

 

Model OS CPU Flash SDRAM Ethernet 
VGA 

Resolution 

RS-232/ 

RS-485 
I/O Expansion Bus Audio Port 

WP-5141 

CE5.0 
PXA270 

520 MHz 
64 MB 128 MB 2 800 x 600 

2/1 

Yes 

(for XW-board only) 

- 

WP-5141-OD Yes 

WP-5151 

1/2 

- 

WP-5151-OD Yes 
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1.2.  Features 

The key features of WinPAC-5000 include: 

 

 Windows CE.Net 5.0 

● Supports PC based software: eVC and VS.NET 

● Web server, FTP server, Telnet server 

● ISaGRAF version for IEC 61131-3 programming 

● InduSoft version for SCADA solution 

 

 Local I/O and Communication Expansion Board 

WinPAC-5000 

series equip an 

I/O expansion 

bus to support 

one optional 

expansion 

board, called XW-board. It can be used to 

implement various I/O functions such as DI, 

DO, A/D, D/A, Timer/Counter and various 

communication interface, such as 

RS-232/422/485, CAN, FRnet, etc. 
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 Various Memory Expansions 

WinPAC-5000 provides various memory storage options, such 

as EEPROM and microSD. Customers can choose the 

memory based on their characteristics. 

 

● 16 KB EEPROM: to store not frequently changed 

parameters. 

● microSD/microSDHC: to implement portable data logging applications. 

 

 Unique 64-bit Hardware Serial Number to Protect Your Program 

A unique 64-bit serial number is assigned to each hardware device to protect your 

software against piracy. 

 

 Remote I/O Module and Expansion Unit 

With the built-in RS-485 and Ethernet port, the 

5000 series can connect RS-485/Ethernet 

remote I/O units (RU-87Pn/ET-87Pn) or modules 

(I-7000/M-7000/ET-7000). With an XW-board, 

the 5000 series can have more communication 

ports or different interface to connect to other 

type of devices, for example: CANOpen devices, 

DeviceNet devices, or FRnet I/O modules. 

 

 Plastic and Metal Casing 

The default case is plastic material, 

customers can choose metal case if they want. 
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 Multi-Communication Interface 

There are several of communication interfaces to expand I/O and connect to 

external devices: 

 

 Small and Easy Installation 

WinPAC-5000 Series have a palm-size shape 

(91 mm x 132 mm x 52 mm) to be installed in a 

narrow space with DIN-Rail. 

 

 Highly Reliable Under Harsh Environment 

Our WinPACs operate in a wide range of 

temperature and humidity. 

● Operating Temperature: -25 ~ +75 °C 

● Storage Temperature: -30 ~ +80 °C 

● Humidity: 10% ~ 90% RH, 

non-condensing 
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1.3.  Specifications 

Models WP-5141 WP-5141-OD WP-5151 WP-5151-OD 

System Software 

OS Windows CE 5.0 

.Net Compact Framework 2.0/3.5 

Embedded Service FTP server, Web server (supports VB script, JAVA script), Embedded 

SQL server 

SDK provided Dll for eVC, Dll for Visual Studio.Net 2003/2005/2008 

CPU Module 

CPU PXA270 or compatible (32-bit and 520 MHz) 

SDRAM 128 MB 

Flash 64 MB (32 MB for OS, 32 MB for System_Disk and System Registry) 

EEPROM 16 KB Data Retention: 40 Years; 1,000,000 erase/write cycles 

Expansion Flash Memory microSD socket with a microSD card (support up to 16 GB microSD card) 

RTC (Real Time Clock) Provide second, minute, hour, date, day of week, month, year 

64-bit Hardware Serial 

Number 

Yes 

Dual Watchdog Timers Yes 

LED Indicator 3 LEDs (RUN/PWR, L1 ~ L2; RUN/PWR for status indications, L1 ~ L2 

for user programmable) 

Rotary Switch Yes (0 ~ 9) 

VGA & Communication Ports 

VGA 640 x 480 or 800 x 600 

Ethernet RJ-45 x 2, 10/100 Base-TX (Auto-negotiating, Auto MDI/MDI-X, LED 

indicators) 

USB 1.1 (client) 1 

USB 1.1 (host) 1 

Audio Port 

(Microphone-In and 

Earphone-Out) 

- Yes - Yes 

COM1 RS-232 (RxD, TxD and GND); Non-isolated 

COM2 RS-485 (D2+, D2-); 2500 VDC; isolated 

COM3 RS-232 (RxD, TxD and GND); 

Non-isolated 

RS-485 (D3+, D3-); 2500 VDC; 

isolated 
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Models WP-5141 WP-5141-OD WP-5151 WP-5151-OD 

I/O Expansion 

I/O Expansion Bus Yes, to mount one optional XW-board 

Mechanical 

Dimensions (W x L x H) 91 mm x 132 mm x 52 mm 

Installation DIN-Rail Mounting 

Environmental 

Operating Temperature -25 ~ +75 °C 

Storage Temperature -30 ~ +80 °C 

Ambient Relative Humidity 10 ~ 90% (non-condensing) 

Power 

Input Range +10 ~ +30 VDC 

Isolation 1 kV 

Consumption 4.8 W(0.2 A @ 

24 VDC) 

6 W (0.25 A @ 

24 VDC) 

4.8 W (0.2 A 

@ 24 VDC) 

6 W (0.25 A @ 

24 VDC) 
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1.4.  Overview 

Here is a brief overview of the components and its descriptions for module status. 

Front Panel 

The front panel includes programmable LED indicators. 

 

 

 

 

 

 

 

 

 

 

 

 

 LED Indicators 

LED indicators provide a very convenient way of status indications for faster, easier 

diagnostics. 

LED 

Name 
Color (ON State) Meaning 

RUN/PWR 
Green Power is on 

Orange Power on and OS is running 

L1 Green User programmable control LED 

L2 Green User programmable control LED 
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Tips & Warnings 

The LED indicators can be programmed with WinPAC API. If not 

necessary, do not use RUN that is assigned to the OS-status 

indicators.  

 

 

 

 

Top Panel 

The top panel includes a microSD socket, VGA port, USB client and rotary switch. 

 

 

 microSD socket 

The microSD socket provides an easy way to expand the available storage with a 

microSD card up to 16 GB maximum. 
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 VGA port 

External VGA port provides an easy connection to a monitor or touch panel.  

 

 USB Client 

USB Client is used to for ActiveSync application. An accessory 

USB cable is available to connect the client port with USB mini-B 

type to USB. Type A plug on a PC for ActiveSync application. 

  

 Rotary Switch 

The rotary switch is used to select the operating mode. For more information about 

the operating mode, please refer to section 2.2. Configuring the Boot Mode. 
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Bottom Panel 

The bottom panel includes a microphone, an earphone, a USB host, a connector 

and two Ethernet ports 

 

 Microphone-in and Earphone-out (for WP-5141-OD/WP-5151-OD only) 

The microphone and an earphone jack to allow the input and the output of the audio 

system. 

 

 Ethernet Port (LAN1 and LAN2) 

The Ethernet ports are the opening on WinPAC-5000 network equipment that 

Ethernet cables plug into. Ethernet ports accept cables with RJ-45 connectors. 
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 USB Host 

A USB host controller is a machine with a root hub which allows several 

input devices to be connected to it, such as mice and keyboards. 

 

 Connector 

The pin assignments of the connector are as follows: 

WP-5141/WP-5141-OD 

Pin Signal Description 

 1 F.G Frame Ground 

 2 GND 
Power Input 

 3 PWR 

 4 TxD 
COM3: RS-232 

 5 RxD 

 6 D- 
COM2: RS-485 

 7 D+ 

 8 GND 

COM1: RS-232  9 TxD 

 10 RxD 

WP-5151/WP-5151-OD 

Pin Signal Description 

 1 F.G Frame Ground 

 2 GND 
Power Input 

 3 PWR 

 4 D- 
COM3: RS-485 

 5 D+ 

 6 D- 
COM2: RS-485 

 7 D+ 

 8 GND 

COM1: RS-232  9 TxD 

 10 RxD 
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COM1 (3-Pins, RS-232) 

Note: CPU internal UART 

Baud Rate: 15200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps 

Data Bits: 7, 8 

Parity: None, Even, Odd 

Stop Bits: 1 

FIFO: 1 byte 

 

COM2 (2-Pins, RS-485) 

Note: 16C550 compatible 

Baud Rate: 15200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps 

Data Bits: 7, 8 

Parity: None, Even, Odd, Mark (Always 1), Space (Always 0) 

Stop Bits: 1, 2 

FIFO: 16 bytes 

 

COM3 (3-Pins, RS-232 for WP-5141/WP-5141-OD) 

Note: 16C550 compatible 

Baud Rate: 15200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps 

Data Bits: 7, 8 

Parity: None, Even, Odd, Mark (Always 1), Space (Always 0) 

Stop Bits: 1, 2 

FIFO: 16 bytes 
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COM3 (3-Pins, RS-485 for WP-5151/WP-5151-OD) 

Note: 16C550 compatible 

Baud Rate: 15200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps 

Data Bits: 7, 8 

Parity: None, Even, Odd, Mark (Always 1), Space (Always 0) 

Stop Bits: 1, 2 

FIFO: 16 bytes 
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1.5.  Dimension 

All dimensions are in millimeters. 

 WP-5141/WP-5151 
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 WP-5141/WP-5151 with XW-board 
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 WP-5141-OD/WP-5151-OD 
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 WP-5141-OD/WP-5151-OD with XW-board 
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1.6.  Companion CD 

This package comes with a CD that provides drivers, software utility, all of the 

required documentations…, etc. All of them are listed below. 

 

CD:\napdos 

wp-5000_ce50 

Backup 

Backup files related to the documents, OS images, SDKs...., etc. 

Demo 

Demos related to WinPAC 

Document 

Document related to WinPAC 

Micro_SD 

Tools and drivers related to manage the microSD 

OS_Image 

OS_Image related to WinPAC 

PC_Tools 

Tools related to management WinPAC that install on PC 

SDK 

SDKs related to WinPAC 

System_Disk 

Tools and drivers related to System_Disk that install  on WinPAC 

Update 

Installation packages related to WinPAC updates 



 

WinPAC-5000 Series User Manual, Version 1.0.8                    Page: 26 

Copyright © 2014 ICP DAS Co., Ltd. All Rights Reserved. E-mail: service@icpdas.com 

2.  Getting Started 

If you are a new user, begin with this chapter, it includes a guided tour for basic 

overview of installation and configuration. 

In addition to Quick Start Guide, the package includes the following items, if any 

items are damaged or missing, please contact us. 

 

 

   

WinPAC Module A microSD Card and  Software Utility CD Screw Driver 

WP-5141 

WP-5141-OD 

WP-5151 

WP-5151-OD 

a microSD/SD Adapter 

 

(1C016) 

2.4 mm 
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2.1.  Mounting the Hardware 

Before installing the hardware, you should have a basic understanding of hardware 

specification, such as the size of hard drive, the usable input-voltage range of the 

power supply, and the type of communication interfaces. 

 

For complete hardware details, please refer to section “1.3. Specifications” You also 

need to know the expansion capacities in order to choose the best expansion 

module for achieving maximal efficiency. 

 

For more information about expansion module that are compatible with the unit, 

please refer to  

http://www.icpdas.com.tw/product/solutions/pac/upac/xw-board_selection.html 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.icpdas.com.tw/product/solutions/pac/upac/xw-board_selection.html
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Step 1: Mounting WinPAC-5000 

● The WinPAC-5000 can be mounted with the bottom of the chassis on the DIN rail, 

the wall or piggyback. 

● To clean the unit, wipe it with a clean, dry cloth. 

● Maintain the following conditions: 

▪ Operating Temperature: -25 °C to +75 °C 

▪ Storage Temperature: -30 °C to +80 °C 

▪ Relative Humidity: 10% to 90%, non-condensing 

 

Mounting on DIN rail Removing from DIN rail 

            

 

 DIN rail mounting 

The WinPAC-5000 has simple 

rail clips for mounting reliably on 

a standard 35 mm DIN rail. 

 

 Piggyback mounting 

The WinPAC-5000 has two holes on both sides for 

piggyback mounting. 
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Step 2: Connecting to a microphone, an audio, a PC, the USB device, and the 

power supply 

i. Connect the mouse or keyboard to the USB port. 

ii. Connect the microphone and earphone to the microphone-in and earphone-out  

(for WP-5141-OD/WP-5151-OD only) 

iii. Connect PC to the Ethernet port through a hub.  

iv. Connect the power supply (10 ~ 30 VDC) to PWR and GND terminals. 

v. Connect the monitor to the VGA port. 
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2.2.  Configuring the Boot Mode 

The WinPAC-5000 has the following seven main operating modes, which can be 

selected by a rotary switch. 

 

 

 

Rotary switch position Modes of operation 

0 Normal mode (Default) 

1 Safe mode 

2 Debug mode 

3 OS update mode 

4 Development mode 

5 DCON_CE 

6 VCEP 

7 ~ 9 (For user) 

 

 

The following is an overview of the seven modes. 

Normal Mode (Default mode) 

Normal mode is the default mode of operation and the one you will use most of the 

time. Use this mode for more tasks and configurations. Programs also are executed 

in this mode. 

Safe Mode 

Safe mode is a trouble shooting. The mode loads the minimum required device 

drivers and system services to boot the WinPAC-5000. 

If you have malicious software or a program caused the WinPAC-5000 cannot be 

boot or run the normal mode, you can boot in safe mode to solve the problem. 
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Debug Mode 

Debug mode is a special environment in which program debug functions can be 

used in addition to normal system functions. 

Debug mode is unsupported. 

OS Update Mode 

OS update mode is a way used to update OS. For more information on updating the 

WinPAC-5000 OS image, please refer to section 6.1. OS updates 

Development Mode 

 

DCON_CE 

In this mode, the DCON_CE will be run automatically, and other settings are same 

as the normal mode. 

For more information about the VCEP, please refer to section 3.3. DCON_CE. 

VCEP 

In this mode, the VCEP will be run automatically, and other settings are same as the 

normal mode. 

For more information about the VCEP, please refer to section 3.5 VCEP. 

User Mode 

The positions 7, 8, 9 of rotary switch are reserved for user‟s applications. 

When WinPAC-5000 is boot with one of these positions, it is boot at normal mode. 

User‟s application can check the rotary switch position to run at different mode. 
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2.3.  Changing the Language of the User Interface 

The WinPAC-5000 is a Windows CE-based operating system which provides 

multilingual user interface and the user interface can be set to one of multi 

languages. 

Step 1: Open the Control Panel 

Step 2: Run the Regional 

Settings 

 

 

 

 

 

 

Step 3: Choose the display language, 

and then click OK 
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Step 4: Run the WinPAC Utility 

 

 

 

 

 

 

 

 

 

 

Step 5: On the File menu, click 

Save and Reboot 

 

 

 

 

Step 6: Click “Yes” to reboot the WinPAC-5000 
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2.4.  Using WinPAC Utility to Configure 
WinPAC Basic Functionality 

WinPAC Utility is a tool that provides ability to configure the WinPAC-5000 services.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For more information on how to use the WinPAC Utility, please refer to section 3.6. 

WinPAC Utility. 
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2.5.  Using Backup Utility to Back up the 
Settings and Files 

After saving the configuration settings for a WinPAC device following the first use, it 

is recommended to use the Backup utility to back up all the data (settings and files). 

 

Step 1: Run the Backup Utility on the WinPAC  

The Backup Utility is located at: 

\System_Disk\tools\Backup_utility\ 

Step 2: Click the Backup menu 

 

 

 

 

 

 

 

 

 

 

 

Step 3: Select the options that you 

want to backup, enter text 

annotations and then click 

the Start backup button 
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Step 4: Confirm the backup 

options and then click 

Yes button 

Step 5: Choose the folder that you want 

to save backup file and click the Ok 

button 

 

 

 

 

Step 6: Wait for process to finish 
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3.  Tools and Tasks 

Following tools has been installed on WinPAC-5000. 

 

CD:\Napdos 

wp-5000_ce50 

System_Disk 

Tools 

Backup_Utility 

Dcomcnfg 

DCON_CE 

DCON_Utility_CE5 

ISQLW35 

Modbus 

modbus_master_tool 

NAPOPC_CE5 

Quicker 

RegistryEditor 

RegistryViewer 

Remote_display_application 

SendToCOM 

TaskMgr 

VCEP 

WinPAC_Utility 
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 Backup_Utility 

The Backup_Utility is a system backup/restore tool used to backup/restore all the 

data (OS, settings and files) from/to the WinPAC/ViewPAC device. 

 Dcomcnfg 

dcomcnfg.exe for Windows CE to configure your DCOM settings. 

NTLMUser.exe for Windows CE to create local NTLM accounts on the Windows CE 

Device. 

 DCON_CE 

With Host PC running the DCON Utility, on the WinPAC, the DCON_CE program 

allows user to view and monitor the status of the DCON Utility. 

 ISQLW35 

The ISQLW35 implements SQL server compact 3.5 Query Analyzer. 

 Modbus 

The Modbus provides various applications of Modbus protocol for configuring the 

WinPAC. 

 NAPOPC_CE5 

NAPOPC_CE5 is an integrated omnibus software package, it allows user to quickly 

establish a DCS control system. 

 Registry Editor 

The Registry Editor allows user to editor the registry value of Windows CE Operating 

System. 
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 Remote display application  

The remote display application allows user to view the display remotely of the 

WinPAC on a Host PC. 

 SendToCOM 

The SendToCOM allows user to send/receive data to/from the expansion module via 

serial port. 

 TaskMgr 

The TaskMgr provides details about programs and processes running on the 

WinPAC. 

 VCEP 

The VCEP allows user to manage the WinPAC remotely on a Host PC. 

 WinPAC Utility 

The WinPAC Utility provides various useful functions such as configuring Ethernet 

settings, monitoring system settings and FTP services for easy and quick 

management. 
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3.1.  Backup Utility 

Backup Utility is an application program for backing up data.  

With this utility, you can easily back up not only the files and folders you have 

created on your WinPAC-5000 but also the entire partition(s) including your 

WinPAC-5000 operating environment and its settings and dictionaries. 

 

Below are the step-by-step procedures to use the Backup utility to back up data. 

 

Step 1: Run the Backup Utility on the WinPAC  

The Backup Utility is located at: 

\System_Disk\tools\Backup_utility\ 

Step 2: Click the Backup menu 

 

 

 

 

 

 

 

 

 

 

Step 3: Select the options that you 

want to backup, enter text 

annotations and then click 

the Start backup button 
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Step 4: Confirm the backup 

options and then click 

Yes button 

Step 5: Choose the folder that you want 

to save backup file and click the Ok 

button 

 

 

 

 

 

Step 6: Wait for process to finish 
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3.2.  Dconmcnfg 

DCOMCNFG is a utility included with Microsoft Windows CE operating system and 

is used to configure various DCOM-specific settings in the registry. You can use the 

registry to specify default permissions for objects on the system, such as Access, 

Launch, and Configuration. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

WinPAC-5000 Series User Manual, Version 1.0.8                    Page: 43 

Copyright © 2014 ICP DAS Co., Ltd. All Rights Reserved. E-mail: service@icpdas.com 

3.3.  Napopc_ce5 

NAPOPC_CE5 DA Server is a free OPC DA Server (The "OPC" 

stands for "OLE for Process Control" and the "DA" stands for " 

Data Access") working on WinPAC, ViewPAC & WinCon 

controllers provided by ICP DAS Ltd. The first standard (originally 

called simply the OPC Specification and now called the Data 

Access Specification) resulted from the collaboration of a number of leading 

worldwide automation suppliers working in cooperation with Microsoft. Originally 

based on Microsoft's OLE COM (component object model) and DCOM (distributed 

component object model) technologies, the specification defined a standard set of 

objects, interfaces and methods for use in process control and manufacturing 

automation applications to facilitate interoperability. NAPOPC_CE5 DA Server 

integrates OPC, Modbus TCP Slave and Modbus RTU Slave three kind Slave 

services, as well as integrates Modbus TCP Master, Modbus RTU Master and 

DCON three kind Master communication protocols. It also provides one advanced 

function “Rule Script” for use in the I/O integration and transformation, and some 

conditional Logic operation. 

 

Any version before 2.1.0 of the NAPOPC_CE5 was named “Quicker” 
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3.4.  SendToCOM 

The SendToCOM uses the serial port to communicate with expansion module. To 

use the SendToCOM, you can send data to expansion module through the serial 

port, and receive data from other device through the serial port. 

 

For more information about these commands for communicating with expansion 

module, please refer to: 

CD:\Napdos\io_module\87k_high_profile_modules.htm 
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3.5.  VCEP 

ICPDAS VCEP is designed 

for managing your WinPAC 

anywhere. No matter where 

you are, ICPDAS VCEP 

provides a convenient 

environment on the Desktop 

PC and allows you control 

your WinPAC remotely. 

 

ICPDAS VCEP is composed of two main components: 

The “Server” which runs on WinPAC. 

The “Client" which runs on a Desktop PC. 

 

Once a connection is established between the client and server (initiated by the 

client), the client will periodically send requests for screen updates and send 

mouse/key click information to the server to simulate. Each video frame is 

inter-compressed against the previous frame and then intra-compressed with a 

modified LZW scheme to minimize the amount of data transmitted from server to 

client. 

 

For more detailed information on VCEP application, please refer to 

ftp://ftp.icpdas.com.tw/pub/cd/winpac/napdos/wp-8x4x_ce50/pc_tools/vcep_4.2.0.9/ 

 

 

 

 

 

 

 

ftp://ftp.icpdas.com.tw/pub/cd/winpac/napdos/wp-8x4x_ce50/pc_tools/vcep_4.2.0.9/
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3.6.  WinPAC_Utility 

The WinPAC Utility is a tool which is designed to quickly control and manage the 

WinPAC. 
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3.6.1.  Menu Bar 

The WinPAC Utility includes the following function menu. All functions menu will be 

explained later. 

 

 

File Menu 

 

 

Help Menu 

 

 

Configuration Menu 
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 File Menu 

 

 

 

The menu commands Use to 

Save Save the settings into Flash. 

The new settings don‟t take effect until the 

WinPAC restart. 

Save and Reboot Save the settings into Flash and restart the 

WinPAC. 

The new settings will take effect after the 

WinPAC restart. 

Reboot Without Save Restarts the WinPAC without save the settings 

into Flash. 

Restore Default 

Settings 

Restarts the settings of WinPAC to its factory 

default values. 

The settings include configuration setting, 

network setting, auto execution, etc. 

Exit Exits the WinPAC Utility. 
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 Help Menu 

 

 

 

The menu commands Use to 

Reset System to 

Default 

Resets the system interrupt status to default. 

The operation used in the situation when the 

interrupt crash. 

You can select this operation to reset the 

interrupt status without rebooting the device. 

Release Notes Checks out what‟s new and the know issues. 

About Displays a dialog box with information about 

WinPAC Utility, including the current version and 

copyright information. 
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 Configuration Menu 

 

 

 

The menu commands Use to 

Import Registry Key Backs up a sub-key of registry by using a 

registration entry (.reg) file. 

 

How to use: 

Step 1: Select the “Import Registry Key”, then 

the “Open” dialog box will appear 

Step 2: On the “Open” dialog box, select a 

specific .reg file to import 

 

Warning: 

1. The .reg file which should be saved by 

“Export Registry Key”. 

2. It will not save automatically after import 

a .reg file. 

Export Registry Key Makes a backup of a registry sub-key 

 

How to use: 

Step 1: Select the “Export Registry Key”, then 

the “Export Registry” box will appear 

Step 2: Select a specific root key 

Step 3: Input a specific path of sub-key 

Step 4: Push the “OK” button, then the “Save 

As” dialog box will appear prompting you to 
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The menu commands Use to 

select a location where you want to save this 

exported file 

 

Warning: 

The export operation will export all the sub-keys 

of the specific key which you input. 

Store All Registry 

Setting 

Stores all registry setting to flash from .das file 

which is saved by “Dump All Registry Setting”. 

 

How to use: 

Step 1: Select the “Store All Registry Setting” , 

then the “Open” dialog box will appear 

Step 2: On the “Open” dialog box, select a 

specific .das file to store 

 

Warning: 

1. The .das file which should be saved by 

“Dump All Registry Setting”. 

2. It will save automatically after store .das file. 

Dump All Registry 

Settings 

Dump all registries setting to .das file. 

 

How to use: 

Select the “Dump All Registry Setting”, then the 

“Save As” dialog box will appear prompting you 

to select a location where you want to save this 

exported file. 
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3.6.2.  Property Tabs 

The WinPAC Utility includes the following property tabs, all property tabs will be 

explained later. 

 

 

 System Settings 

 System Settings2 

 Ethernet Settings 

 Network Settings 

 System Information 

 Auto Execution 

 Multi-serial port wizard 

 System Memory Setting 
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 System Settings Tab 

The System Settings tab provides functions to configure the task bar. 

 

The tab use to How to use 

Adjust the size of the desktop Select a display resolution from the 

Resolution list. 

Lock or Auto-Hide the taskbar Auto-Hide: Select the Auto Hide check box 

Lock: Select the Always On Top check box. 

Change the HTTP directory 

path 

Enter a new path in the Change HTTP 

document root directory 

\windows\www\wwwpub to field, and then 

press the Setting button. 

Automatic synchronization of 

system time 

Refer to the Appendix A.6 How to configure 

the service for automatically synchronizing 

with the internet time server 

* The battery initial voltage should be around 2.8~3.0V, when below 2.1V, the 

WinPAC/ViewPAC Utility will show the low power warning. When below 1.5V, the 

data in the RTC (real time clock) and 512KB SDRAM will be lost. Proceed to 

replace the PCs battery. The battery type: BR1225. 
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 System Settings2 Tab 

The System tab provides functions to set the name of the MicroSD card and the 

USB hard disk. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Set the name of the MicroSD card 

ant the USB hard disk 

Enter the name of the MicroSD card and 

the USB hard disk in the relevant fields, 

and then press the Set button 
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 Ethernet Settings Tab 

The Ethernet Settings tab provides functions to configure either DHCP (Roaming) or 

manually configured (Static) network settings and to monitor the MAC address. 

Generally, DHCP is the default settings, but if you don‟t have a DHCP server, you 

must configure the network settings by using manual configuration. 

 

 

The tab use to How to use 

Configure the network 

settings 

Obtaining an IP address automatically from DHCP: 

Select the Use DHCP to get IP address option. 

Manually assign an IP address: 

Select the Assign IP address option. 

Monitor the MAC 

address 

See the MAC Address 1 and MAC Address 2 fields 

that display the physical address of LAN1 and LAN2. 
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 Network Settings Tab 

The Network Settings tab includes three tabs, FTP Setting, HTTP directory path, 

Users and Password and File Server Settings. 

The FTP settings tab provides functions to enable/disable the FTP access, 

enable/disable anonymous FTP access, and configure the FTP directory path. 

 

FTP Settings tab 

 

The tab use to How to use 

Enable or disable 

the FTP access 

Enable: 

Select the Enable check box in the FTP field. 

Disable: 

Select the Disable check box in the FTP field. 

Enable or disable 

anonymous FTP 

access 

Enable: 

Select the Enable check box in the Allow Anonymous 

field. 
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The tab use to How to use 

Disable: 

Select the Disable check box in the Allow Anonymous 

field. 

Enable or disable 

anonymous FTP 

upload 

Enable: 

Select the Enable check box in the Allow Anonymous 

Upload field. 

Disable: 

Select the Disable check box in the Allow Anonymous 

Upload field. 

Change the FTP 

directory path 

Enter a new path in the Change FTP default download 

directory field, and then press the Setting button. 

FTP/Telnet 

authentication 

Refer to the Appendix A.1 
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Users and Passwords tab 

 

The tab use to How to use 

Add a user 

account 

Fill in the User name and Password field of your user 

account, press the Add button, and then press the Setting 

button 

Delete a user 

account 

Choose a user name from the user account list, the user 

account that you select will display in the User name and 

Password filed, press the Delete button, and then press the 

Setting button 

* The maximum number of the user accounts is 5. 

* The maximum of the string length of the user name and password fields 

must be less than 20 charachters. 

 

Please refer the document “w2-022_how_to configure_the_File(SMB)_Server “ to 

use the File Server Settings tab. 
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 System Information Tab 

The System Information tab provides functions to monitor necessary system 

information of the WinPAC. The system information is the most important note of 

version control for upgrading system. 

 

Tips & Warnings 

The XW-board series are for uPAC-5000, LP-5000, and 

WP-5000 series. 

One PAC can only plug only one XW-board. The System 

Information tab show the module name for XW-board. 

 

 

 

 



 

WinPAC-5000 Series User Manual, Version 1.0.8                    Page: 60 

Copyright © 2014 ICP DAS Co., Ltd. All Rights Reserved. E-mail: service@icpdas.com 

 Auto Execution Tab 

The Auto Execute tab provides functions to configure programs running at WinPAC 

startup, it allows users to configure ten execute files at most. 

 

Tips & Warnings 

The allowed file types are .exe and .bat, and they are executed in 

order of program 1, program 2, etc. 

 

 

 

 

The tab use to How to use 

Configure programs 

running at startup 

Press the Browse button to select the execute file 

which you want, and then press the Setting button. 
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 Multi-Serial Port Wizard Tab 

The Multi-serial port provides functions for installation of the XW-board driver. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The table below shows the expansion 

communication modules that are compatible 

with the WinPAC-5000. 

 

RS-232/422/485, DI, DO Boards 

Model 
Serial Port 

DI DO Isolation 
Type Ch Wire 

XW506 RS-232 6 3-wire - - 
- 

XW507 RS-422/RS-485 1 4/2-wire 5 5 

XW508 RS-232 8 3-wire - - - 

XW509 RS-232 2 5-wire 4 4 - 

XW511i RS-485 4 2-wire - - 2500 Vrms 

XW514 RS-485 8 2-wire - - - 

 

For more detailed information about these support modules, please refer to 

http://www.icpdas.com/root/product/solutions/pac/upac/xw-board_selection.html 

http://www.icpdas.com/root/product/solutions/pac/upac/xw-board_selection.html
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 System Memory Setting Tab 

The System Memory Setting tab provides functions to adjust and monitor the 

unused RAM.  

 

The tab use to How to use 

Adjust display Move the slider left to release more memory running 

programs or move the slider right to release more 

storage room, and then press the Setting button 
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4.  Your First Program 

When you learn every computer programming language you may realize that the 

first program to demonstrate is "Hello World", it provides a cursory introduction to the 

language's syntax and output. 

 

Before writing your first program, ensure that you have the necessary development 

tools and the corresponding WinPAC-5000 SDKs are installed on your system. 
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4.1.  Preparing the Development Tools 

WinPAC-5000 is a Windows CE-based unit. Windows CE is a mature embedded 

operating system which supports rapid development. Two standard development 

tools are list as follows which are highly integrated, with comprehensive support for 

developing applications of Windows CE-based WinPAC-5000. 

 

 Visual Studio 

 

Visual Studio 

 

WinPAC-5000 has .NET Compact Framework 2.0 installed. Visual Studio takes full 

advantage of the .NET Compact Framework, which uses public Internet standards to 

enable integration with new and existing applications running on any platform. 

Supported languages include Visual C#, and Visual Basic .NET. 

 Microsoft Embedded Visual C++ 

 

 

eMbedded Visual C++ 

 

eMbedded Visual C++ is a standalone integrated development environment (IDE) 

that brings a new level of productivity to Windows CE development without 

compromising flexibility, performance, or control. 
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4.2.  Installing WinPAC-5000 SDK 

The PACSDK is a Software Development Kit (SDK) that contains C header files, C 

libraries and documents. 

Step 1: Insert the CD into your CD-ROM drive 

Step 2: Execute the “PAC270_SDK_YYYYMMDD.msi”  

 The PAC270_SDK_YYMMDD.msi can be obtained from: 

CD:\Napdos\wp-5000_ce50\SDK\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/sdk/ 

 

The installation program for the latest version of the WinPAC Platform SDKs can 

be obtained from: 

http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/sdk/ 

File name: pac270_sdk_yyyymmdd.msi 

yyyymmdd: Platform SDK released date 

 

Tips & Warnings 

The released date of the installation program SDK installation 

package that provides the PACSDK library must be later than or 

equal to 2012/10/15, such as PAC270_SDK_20121015.msi 

 

 

Step 3: Follow the prompts until the installation is complete 

 

 

 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/sdk/
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/sdk/
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Understanding the PACSDK 

The PACSDK includes several application programming interfaces (APIs) that 

allows you perform various supporting tasks when developing WinPAC. 

 

 

 Requirements 

The PACSDK only supports .NET Compact Framework 2.0 or above. 

 

 Installation Path 

After installing the PACSDK, a number of functions can be installed on the Host 

PC, and this installation puts the header files, libraries into the following public 

places so they are easily changed by update the PACSDK. 

 

Header files: 

C:\Program Files\Windows CE Tools\wce500\PAC270\Icpdas\Include\ARMV4I\ 

 

Libraries: 

C:\Program Files\Windows CE Tools\wce500\PAC270\Icpdas\Lib\ARMV4I\ 

 

PACSDK Reference 

For full usage information regarding the description, prototype and the arguments 

of the functions, please refer to the “PAC Standard API Manual” located at: 

 For WP-5000 series 

CD:\Napdos\wp-5000_ce50\Document\SDK_Document\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/document/sdk_docum

ent/ 

 

 

 

 

 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/document/sdk_document/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/document/sdk_document/
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4.3.  Your First Program in C# 

Here we will demonstrate how to create a C# program running on WinPAC-5000 

with the C# development tool, which including the following topics: 

 

1. Create a new project 

2. Add WinPAC-5000 reference 

3. Add the control to the form 

4. Add the event handling for the control 

5. Upload the application to WinPAC-5000 

6. Execute the application on WinPAC-5000 

 

In this tutorial, we will assume that you have installed WinPAC-5000 SDK on PC and 

used the Visual Studio 2005/2008 for application development. 
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4.3.1.  Creating a New Project 

The Visual C# project template is a composite control that you use in this example 

creates a new project with this user control. 

 

Step 1: Start Visual Studio 2005/2008 

 

Visual Studio 2005/2008 

 

 

 

Step 2: On the File menu, point to New, and then click Project… 
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Step 3: In the Project types pane, expand Visual C#, and then click Window 

CE5.0 

Step 4: In the Templates pane, click Device Applications 

Step 5: Type a name in the Name field, and then click OK 

Here we will enter the name “systeminfo” and a different location for the project if 

you wish 
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4.3.2.  Adding the WinPAC-5000 Reference 

The WinPAC-5000 SDKs provides a 

complete solution to integrate with 

WinPAC-5000. Compatible with Visual C#, 

Visual Basic .net and C++. In order to use a 

component in your application, you must 

first add a reference to it. 

Step 1: In Solution Explorer, right-click the 

References node and click Add 

Reference on the shortcut menu 

The Add Reference dialog box appears. 

Step 2: Click the Browse 

tab, and then select 

PACNET.dll 

 

 

 

 

 

 

 The “PACNET.dll” file can be obtained from: 

CD:\Napdos\wp-5000_ce50\SDK\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/sdk/ 

or CD:\Napdos\wp-8x4x_ce50\sdk\winpacnet\pacnet 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/sdk/winpacnet/p

acnet/ 

Step 3: Click OK to close the Add Reference dialog box 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/sdk/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/sdk/winpacnet/pacnet/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/sdk/winpacnet/pacnet/
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4.3.3.  Adding the Control to the Form 

You can drag various controls from the Toolbox onto the form. These controls are not 

really "live"; they are just images that are convenient to move around on the form 

into a precise location. 

After you add a control to your form, you can use the Properties window to set its 

properties, such as background color and default text. The values that you specify in 

the Properties window are the initial values that will be assigned to that property 

when the control is created at run time. 

Step 1: From the Toolbox, drag a Button control onto the form 

 

Step 2: Right-click the Button control, and then click 

Properties 
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Step 3: In the Properties window, type Check the OS version, and press ENTER to 

set the Text property 
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4.3.4.  Adding the Event Handling to the Control 

You have finished the design stage of your application and are at the point when you 

can start adding some code to provide the program's functionality. 

Step 1: Double-click the button on the form 

 

 

The Code Editor opens with the cursor 

positioned in the event handler. 

 

 

Step 2: Inserting the following code into the header area using PACNET; 

 

 

 

 

 

 

 

 

 

Tips & Warnings 

The “PACNET” of “using PACNET” is case- sensitive. 
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Step 3: Inserting the following code 

MessageBox.Show(PACNET.Sys.GetOSVersion()); 

MessageBox.Show(Sys.GetOSVersion()); 
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4.3.5.  Upload the Application to WinPAC-5000 

WinPAC-5000 provide FTP server service, you can upload files to WinPAC-5000 or 

download files from a public FTP server.  

 

 

 

Step 1: On the Build menu, click Build Solution 

 

 

Step 2: Open the browser and type the IP address of WinPAC-5000 

………
………
………
………

………...
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Step 3: Upload the systeminfo.exe application and the corresponding PACNET.dll 

file to the WinPAC-5000 

 

Tips & Warnings 

For applications programming in C# and VB.net with .net 

compact framework, when executing these application on the 

WinPAC-5000 controller, the corresponding “PACNET.dll” file 

must be in the same directory as the .exe file. 
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4.3.6.  Executing the Application on WinPAC-5000 

After uploading the application to WinPAC-5000, you can just double-click it on 

WinPAC-5000 to execute it. 
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4.4.  Your First Program in VB.net 

Here we will demonstrate how to create a VB.net program running on WinPAC-5000 

with the VB.net development tool, which including the following topics: 

 

1. Create a new project 

2. Add WinPAC-5000 reference 

3. Add the control to the form 

4. Add the event handling for the control 

5. Upload the application to WinPAC-5000 

6. Execute the application on WinPAC-5000 

 

In this tutorial, we will assume that you have installed WinPAC-5000 SDK on PC and 

used the Visual Studio 2005/2008 for application development. 
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4.4.1.  Creating a New Project 

The VB.net project template is a composite control that you use in this example 

creates a new project with this user control. 

 

Step 1: Start Visual Studio 2005/2008  

 

Visual Studio 2005/2008 

 

Step 2: On the File menu, point to New, and then click Project… 
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Step 3: In the Project types pane, expand Visual Basic, and then click Window 

CE5.0 

Step 4: In the Templates pane, click Device Applications 

Step 5: Type a name in the Name field, and then click OK 

Here we will enter the name “systeminfo” and a different location for the project if 

you wish 
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4.4.2.  Adding the WinPAC-5000 Reference 

The WinPAC-5000 SDKs provides a 

complete solution to integrate with 

WinPAC-5000. Compatible with Visual C#, 

Visual Basic .net and C++. In order to use 

a component in your application, you 

must first add a reference to it. 

Step 1: In Solution Explorer, right-click 

the References node and click 

Add Reference on the shortcut 

menu. 

The Add Reference dialog box appears. 

Step 2: Click the Browse tab, 

and then select 

PACNET.dll 

 

 

 

 

 

 The “PACNET.dll” file can be obtained from: 

CD:\Napdos\wp-5000_ce50\SDK\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/sdk/ 

or CD:\Napdos\wp-8x4x_ce50\sdk\winpacnet\pacnet 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/sdk/winpacnet/p

acnet/ 

Step 3: Click OK to close the Add Reference dialog box 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/sdk/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/sdk/winpacnet/pacnet/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/sdk/winpacnet/pacnet/
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4.4.3.  Adding the Control to the Form 

You can drag various controls from the Toolbox onto the form. These controls are not 

really "live"; they are just images that are convenient to move around on the form 

into a precise location. 

After you add a control to your form, you can right-click the control and select 

Properties to set its properties, such as background color and default text. The 

values that you specify in the Properties window are the initial values that will be 

assigned to that property when the control is created at run time. 

Step 1: From the Toolbox, drag a Button control onto the form 

 

Step 2: Right-click the Button control, and then click 

Properties 
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Step 3: In the Properties window, type Check the OS version, and press ENTER to 

set the Text property 
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4.4.4.  Adding the Event Handling to the Control 

You have finished the design stage of your application and are at the point when you 

can start adding some code to provide the program's functionality. 

Step 1: Double-click the button on the form 

 

 

 

The Code Editor opens with the cursor 

positioned in the event handler. 

 

Step 2: Inserting the following code 

1. Imports PACNET 

2. MessageBox.Show(PACNET.Sys.GetOSVersion()) 

MessageBox.Show(Sys.GetOSVersion()) 

 

 

 

 

 

 

 

 

 

Tips & Warnings 

The “PACNET” of “using PACNET” is case- sensitive.. 

 

1 

2 
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4.4.5.  Upload the Application to WinPAC-5000 

WinPAC-5000 provide FTP server service, you can upload files to WinPAC-5000 or 

download files from a public FTP server.  

 

 

 

Step 1: On the Build menu, click Build Solution 

 

 

Step 2: Open the browser and type the IP address of WinPAC-5000 

………
………
………
………

………...
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Step 3: Upload the systeminfo.exe application and the corresponding PACNET.dll 

file to the WinPAC-5000 

 

Tips & Warnings 

For applications programming in C# and VB.net with .net 

framework, when executing these application on the 

WinPAC-5000 controller, the corresponding “PACNET.dll” file 

must be in the same directory as the .exe file. 
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4.4.6.  Executing the Application on WinPAC-5000 

After uploading the application to WinPAC-5000, then you can just double-click it on 

WinPAC-5000 to execute it. 
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4.5.  Your First Program in eMbedded Visual C++ 

Here we will demonstrate how to create an eVC++ program running on 

WinPAC-5000 with the eVC++ development tool, which including the following 

topics: 

 

1. Create a new Forms-Based project 

2. Configure the platform 

3. Specify the path of the WinPAC-5000 reference 

4. Add the control to the form 

5. Add the event handling for the control 

6. Upload the application to WinPAC-5000 

7. Execute the application on WinPAC-5000 

 

In this tutorial, we will assume that you have installed WinPAC-5000 SDK on PC and 

used the eMbedded Visual C++ 4.0 for application development. 
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4.5.1.  Creating a Forms-Based Project 

The eVC++ project template is a composite control that you use in this example 

creates a new project with this user control. 

 

Step 1: Start eMbedded Visual C++ 

 

eMbedded Visual C++ 

Step 2: On the File menu, and then click New 

 

Step 3: Click the Projects tab, 

and then select WCE 

Application 

Step 4: Select the CPUs that 

WinPAC-5000 is supported on 

from the CPUs list box  
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Tips & Warnings 

Ensure that Win32 (WCE ARMV4I) is selected in the CPUs list 

box and click OK. 

 

 

 

 

 

Step 5: Click OK to start the wizard 

Step 6: On the first page of the wizard, click Dialog based and then click Next, as 

shown in the following illustration 
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Step 7: On the next page of the wizard, leave all the options as they are, and then 

click Next, as shown in the following illustration 

 

 

 

 

 

 

 

 

 

 

 

 

Step 8: On the next page of the wizard, click Next, as shown in the following 

illustration 
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Step 9: On the next page of the wizard, Click Finish, as shown in the following 

illustration 

 

Step10: When the summary appears, click OK to complete the wizard, as shown in 

the following illustration 
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4.5.2.  Configuring the Platform 

When developing applications by using eMbedded Visual C++, you must configure 

the Platform to indicate what platform and device you intend to download the 

application to. Before you deploy your project, check the platform. 

 

On the Win32 [WCE ARMV4I] Debug configuration toolbar, select Win32 [WCE 

ARMV4I] Release, as shown in the following illustration. 
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4.5.3.  Specifying the Path of the WinPAC-5000 Reference 

The WinPAC-5000 SDKs provides a complete solution to integrate with 

WinPAC-5000. Compatible with Visual C#, Visual Basic .net and C++. In order to 

use a component in your application, you must first add a reference to it. 

Step 1: On the Tools menu, and then click Options 

The Options dialog box appears. 
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Step 2: On the Directories tab, in the Show directories for list, select Include files  

Step 3: Under Directories, type the path of the heard file 

 The specified include path of the header file is default located at: 

C:\Program Files\Windows CE 

Tools\wce500\PAC270\Icpdas\Include\ARMV4I\ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click this button 

to specify the 

path of the 

header file 
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Step 4: In the Show directories for list, select Library files  

Step 5: Under Directories, type the path of the library file 

 The specified include path of the header file is default located at: 

C:\Program Files\Windows CE Tools\wce500\PAC270\Icpdas\Lib\ARMV4I\ 

 

 

 

 

 

 

 

 

 

 

 

 

Step 6: On the Project menu, and then click Settings 

The Project Settings dialog box appears. 

 

 

 

 

 

 

 

 

Click this button 

to specify the 

path of the 

Library files 
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Step 7: On the Link tab, type the PACSDK.lib in the Object/library module field, 

and then click OK 
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4.5.4.  Adding the Control to the Form 

You can drag various controls from the Toolbox onto the form. These controls are not 

really "live"; they are just images that are convenient to move around on the form 

into a precise location. 

After you add a control to your form, you can use the Properties function to set its 

properties, such as background color and default text.  

Step 1: Click Resource View in the Project Workspace pane and expand the 

resources tree by opening the top level folder 

Step 2: Open the Dialog folder and then double-click the dialog resource name 

IDD_SDKINFO_DIALOG 

The resource editor appears in the right pane. 

Step 3: From the Toolbox, 

drag a Button 

control onto the 

form 
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Step 4: Right-click the Button control, and then click Properties 

The Push Button Properties dialog box appears. 

 

 

Step 5: Type Check the OS version in the Captions field, and then click  
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4.5.5.  Adding the Event Handling to the Control 

You have finished the design stage of your application and are at the point when you 

can start adding some code to provide the program's functionality. 

Step 1: Double-click the button on the form 

The Add Member Function dialog box appears. 

 

Step 2: Type the onBtnCheckOS in the Member function name field, and then 

click OK 

 

 

 

 

 

 

 

 

The Code Editor opens with the cursor positioned in the event handler. 
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Step 3: Insert the following code 

char OS[32]; 

TCHAR buf[32]; 

pac_GetOSVersion(OS); 

pac_AnsiToWideString(OS, buf); 

MessageBox(buf,0,MB_OK); 

Step 4: Insert the following code into the header area 

#include “PACSDK.h” 
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4.5.6.  Upload the Application to WinPAC-5000 

WinPAC-5000 provide FTP server service, you can upload files to WinPAC-5000 or 

download files from a public FTP server.  

 

 

 

Step 1: On the Build menu, click Build SDKinfo.exe 

 

 

………
………
………
………

………...



 

WinPAC-5000 Series User Manual, Version 1.0.8                    Page: 103 

Copyright © 2014 ICP DAS Co., Ltd. All Rights Reserved. E-mail: service@icpdas.com 

Step 2: Open the browser and type the IP address of WinPAC-5000 

Step 3: Upload the systeminfo.exe application 
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4.5.7.  Executing the Application on WinPAC-5000 

After uploading the application to WinPAC-5000, then you can just double-click it on 

WinPAC-5000 to execute it. 
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5.  APIs and Demo Programs 

There are several APIs and demo programs that have been designed for 

WinPAC-5000. You can examine the APIs and demo source code, which includes 

numerous functions and comments, to familiarize yourself with WinPAC-5000 APIs 

and quickly develop your own applications quickly by modifying these demo 

programs. 
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5.1.  Demo Programs with C# 

The following C# demos have been designed to demonstrate the various features of 

the WinPAC. 

 

 

5.1.1.  C# Demo Programs for WinPAC Standard API 

The table below describes the WinPAC-5000 demos that have been designed to 

demonstrate the standard operation features of the WinPAC-5000. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

System Operation 

 System Information 

 Interrupt 

 Memory Access 

 Watchdog 

 UART 

 Registry 

 Micro SD 



 

WinPAC-5000 Series User Manual, Version 1.0.8                    Page: 107 

Copyright © 2014 ICP DAS Co., Ltd. All Rights Reserved. E-mail: service@icpdas.com 

Folder Demo Explanation 

system systeminfo Retrieves information about the OS 

version, CPU version, SDK version, 

etc. 

memoryaccess memory Shows how to read/write date 

values from/to EEPROM 

battery_backup_sram Shows how to read or write to the 

battery backup 

watchdog watchdog Displays how the watchdog operate 

microsd microsd_management Shows how to enables/disables 

Micro SD 

registry registry Shows how to read/write date 

values from/to registry 

uart diag Shows how to read the name of 

local I/O modules via UART 

 

For C# application, these demo programs can be obtained from: 

CD:\Napdos\wp-5000_ce50\Demo\WinPAC5000\DOTNET\C#.NET\Standard\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/demo/winpac5000/dotnet

/c%23.net/standard/ 

 

 

 

 

 

 

 

 

 

 

 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/demo/winpac5000/dotnet/c%23.net/standard/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/demo/winpac5000/dotnet/c%23.net/standard/
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5.1.2.  C# Demo Programs for PAC I/O API 

The table below describes the WinPAC-5000 demos that have been designed to 

demonstrate the expansion I/O module features of the WinPAC-5000. 
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Folder Demo Explanation 

GPIO GPIO Shows how to connect and control 

the XW-board series modules. XW107 XW107_demo 

XW506 XW506_demo 

XW507 XW507_demo 

XW509 XW509_demo 

XW511i XW511i_demo  

XW304 XW304_demo 

XW310 XW310_demo 

XW310C XW310C_demo 

 

For C# application, these demo programs can be obtained from: 

CD:\Napdos\wp-5000_ce50\Demo\WinPAC5000\DOTNET\C#.NET\PAC_IO\ 

XWBoard\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/demo/winpac5000/dotnet

/c%23.net/pac_io/xwboard/ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/demo/winpac5000/dotnet/c%23.net/pac_io/xwboard/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/demo/winpac5000/dotnet/c%23.net/pac_io/xwboard/
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5.2.  Demo Programs with eVC++ 

The following eVC++ demos have been designed to demonstrate the various 

features of the WinPAC. 

 

 

5.2.1.  eVC++ Demo Programs for WinPAC Standard API 

The table below describes the WinPAC-5000 demos that have been designed to 

demonstrate the standard operation features of the WinPAC-5000. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

System Operation 

 System Information 

 Interrupt 

 Memory Access 

 Watchdog 

 UART 

 Registry 

 Micro SD 
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Folder Demo Explanation 

system systeminfo Retrieves information about the OS 

version, CPU version, SDK version, 

etc. 

memoryaccess memory Shows how to read/write date 

values from/to EEPROM 

battery_backup_sram Shows how to read or write to the 

battery backup 

watchdog watchdog Displays how the watchdog operate 

microsd microsd_management Shows how to enables/disables 

Micro SD 

registry registry Shows how to read/write date 

values from/to registry 

uart diag Shows how to read the name of 

local I/O modules via UART 

 

For eVC application, these demo programs can be obtained from: 

CD:\Napdos\wp-5000_ce50\Demo\WinPAC5000\eVC\Standard\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/demo/winpac5000/evc/st

andard/ 

 

 

 

 

 

 

 

 

 

 

 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/demo/winpac5000/evc/standard/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/demo/winpac5000/evc/standard/
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5.2.2.  eVC++ Demo Programs for PAC I/O API 

The table below describes the WinPAC-5000 demos that have been designed to 

demonstrate the expansion I/O module features of the WinPAC-5000. 
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Folder Demo Explanation 

GPIO GPIO Shows how to connect and control 

the XW-board series modules. XW107 XW107_demo 

XW506 XW506_demo 

XW507 XW507_demo 

XW509 XW509_demo 

XW511i XW511i_demo 

XW304 XW304_demo 

XW310 XW310_demo 

XW310C XW310C_demo 

 

 

For eVC application, these demo programs can be obtained from: 

CD:\Napdos\wp-5000_ce50\Demo\WinPAC5000\eVC\PAC_IO\XWBoard\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/demo/winpac5000/evc/pa

c_io/xwboard/ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/demo/winpac5000/evc/pac_io/xwboard/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/demo/winpac5000/evc/pac_io/xwboard/
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6.  I/O Modules and SDK Selection 

This chapter describes how to select a suitable I/O expansion module and the 

corresponding SDK library to be used for developing programs on WinPAC-5000 

series devices. 

 

Choosing a SDK Library for an I/O Module 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

RS-485 
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 RS-485 (I-7K series and M-7K series) 

I-7000, M-7000, RU-87Pn and high profile I-87K series modules connect to 

ViewPAC series devices via a twisted-pair, multi-drop, 2-wire RS-485 network. 

 

 I-7K series I/O modules 

Module Native SDK .NET CF SDK 

I-7K series PACSDK.dll PACNET.dll 

I-7K series + I-7088(D) PACSDK_PWM.dll PACNET.dll 

 

For full details regarding I-7K series I/O modules and its demos, please refer to: 

http://ftp.icpdas.com.tw/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/applica

bled_demo_for_7k_module.pdf 

 

 M-7K series I/O modules 

Module Native SDK .NET CF SDK 

M-7K series Modbus Demo Modbus Demo 

 

For more detailed information about M-7K series modules using Modbus protocol 

and its demos, please refer to: 

http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/nmodbus/ 

 

 RU-87Pn + I-87K series I/O modules 

Module Native SDK .NET CF SDK 

RU-87Pn + I-87K Refer to local I/O Refer to local I/O 

 

 Other specified I/O modules 

Module Native SDK .NET CF SDK 

Others PACSDK.dll PACNET.dll 

 

http://ftp.icpdas.com.tw/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/applicabled_demo_for_7k_module.pdf
http://ftp.icpdas.com.tw/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/applicabled_demo_for_7k_module.pdf
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/nmodbus/
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 Ethernet (ET-7K series) 

The Ethernet I/O devices available include ET-7000, I-8KE4/8 and I-8KE4/8-MTCP, 

and support either the DCON or the Modbus/TCP communication protocol. 

 

Module Native SDK .NET CF SDK 

ET-7K Modbus Demo Modbus Demo 

 

For more detailed information about ET-7K series modules using Modbus protocol 

and its demos, please refer to: 

http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/nmodbus/ 

 

 

http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/nmodbus/
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7.  WinPAC-5000 Updates 

ICP DAS will continue to add additional features to WinPAC-5000 SDK and OS in 

the future, so we advise you to periodically check the ICP DAS web site for the latest 

updates. 

 

WinPAC-5000 updates services can be divided into the following two main 

categories: 

 

 

 

CD: \Napdos 

wp-5000_ce50 

os_image 

eboot 

update_from_Eshell 

update_from_file 

SDK 

IO_Modules 

Modbus 

NAPOPC_CE5  

WinconSDK 

WinPacNet 

WinpacSDK 

1. OS updates 

2. SDK updates 
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7.1.  OS Updates 

The updates files of OS image are located on: 

CD:\Napdos\wp-5000_ce50\OS_Image\ 

 

 

There are two ways to update the OS: 

1. Update from file (Please refer to section 6.1.1) 

 (We recommend that you use this one for more quicker and easier to update) 

2. Update from Eshell (Please refer to section 6.1.2) 

 

 

 

 

 

 

 

 

 

 

 

CD: \Napdos 

wp-5000_ce50 

os_image 

eboot 

update_from_Eshell 

update_from_file 

OS_image 

Update_from_files Update_from_eshell 

Upgrade 
LAN1 

Upgrade 
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os_image 

update_from_file 

en sc tc 

update_from_eshell 

en sc tc 

The WinPAC-5000 OS supports multi-language: 

1. en - English 

2. sc - Simplified Chinese 

3. tc - Traditional Chinese 
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7.1.1.  OS Updates Using Installation Package File 

Installation package is easier to upgrade OS image, you just copy the package file 

(.exe) and the corresponding “AutoInit.bat” file to WinPAC-5000, and then 

double-click installation package file to run it. 

 

 

 

 

 

 

 

 

 

Step 1: Get the latest version of the installation package file and the 

corresponding “AutoInit.bat” file uploading to WinPAC-5000 

 The latest version of the installation package file and the corresponding 

“AutoInit.bat” file can be obtained from:  

CD:\Napdos\wp-5000_ce50\OS_image\update_from_file\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/os_image/update_fr

om_file/ 

 The corresponding “AutoInit.bat” file can be obtained from the same folder. 

 

There are several ways to upload these files to WinPAC-5000: 

i. Upload files via Ethernet. 

ii. Upload files via a USB storage device, the removable Micro SD card or FTP 

server 

 

 

Upgrade 

 

--------
--------
--------
--------

 

--------
--------
--------
--------

Installation package file  

& AutoInit.bat file 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/os_image/update_from_file/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/os_image/update_from_file/
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Step 2: Run the installation package file and then click OK to make sure you 

receive the important notice of this procedure will ease flash memory 

 

 

 

 

 

Step 3: Select or clear the Retain the correct registry at next reboot check box 

to keep or remove the current registry settings at next reboot, and then 

click Update Now to start updating the WinPAC-5000 
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This installation procedure will perform the following tasks: 

i. Backup System_Disk 

 

 

 

 

 

Important Warnings 

Be careful, if the boot loader broken off in this step and cannot 

restart in safe mode, you have to send it back to us. 

 

ii. Erase flash disk 

iii. Install OS image 

iv. Set and save registry 

 

Tips & Warnings 

This procedure will reset the registry settings to their default 

settings, and all of your settings will be lost. 

During this time, do not turn off the WinPAC-5000. If the update 

is cancelled before completion, the WinPAC-5000 may become 

damaged and may require servicing or exchange. 

Besides, we recommend that you turn off all other applications 

before starting to upgrade the OS.  
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Step 4: Configure the boot mode in normal mode, and then Click OK 

After completing the above-mentioned tasks, 

the “Warning !” dialog box will appear as 

follow, before clicking OK button, you must 

first turn the rotary switch to the 0 position 

 

 

 

 

 

 

 

 

Tips & Warnings 

If you have selected the Retain the correct registry at next reboot 

check box, after the installation has been completed, and then 

rebooting the WinPAC-5000 in normal mode, the “Warning !” 

dialog box will appear as follow, click OK button to reboot the 

WinPAC-5000  
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Step 5: Check the OS version of WinPAC-5000 

Start the WinPAC Utility, and then select the “System Information” tab to check the 

current OS version. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Check the 

OS version 



 

WinPAC-5000 Series User Manual, Version 1.0.8                    Page: 125 

Copyright © 2014 ICP DAS Co., Ltd. All Rights Reserved. E-mail: service@icpdas.com 

7.1.2.  OS Updates Using Eshell via Ethernet 

By default, the OS updates via LAN1. Therefore, to update the OS image, make 

sure LAN1 is connected to the PC. 

 

 

 

 

 

 

 

 

 

Step 1: Get the latest version of the WinPAC-5000 OS image 

The latest version of the WinPAC OS image can be obtained from:  

CD:\Napdos\wp-5000_ce50\OS_image\update_from_Eshell\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/os_image/updat

e_from_eshell/ 

Step 2: Run the registry clear.exe  

 

The registry clear.exe can be obtained from:  

CD:\Napdos\wp-5000_ce50\PC_Tools\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp

-5000_ce50/pc_tools/ 

 

 

Upgrade 

LAN1 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/os_image/update_from_eshell/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/os_image/update_from_eshell/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/pc_tools/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-5000_ce50/pc_tools/
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Step 3: Configure the boot mode in OS 

update mode 

Turn the rotary switch to “3”, and then 

reboot the WinPAC. 

The Select Device dialog box appears. 

 

Step 4: Select the device which you want 

to update the OS image, and then 

click OK 

Select the device name which you want to 

update the OS image from the list. 

 

Step 5: Select the downloaded OS image 

file, and then click Open 
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Step 6: Configure the boot mode in 

normal mode, and then click OK 

After completing the above-mentioned tasks, 

the “Warning !” dialog box will appear as 

follow, before clicking OK button, you must 

first turn the rotary switch to the 0 position 

 

 

 

 

 

 

 

 

 

 

 

 

Step 7: Run the WinPAC Utility 

 

 

 

 

 

Step 8: On the File menu, click Save 

and Reboot 
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Step 9: Click “Yes” to reboot the WinPAC-5000 

 

Step 10: Check the WinPAC OS version 

Start the WinPAC Utility, and then select the “System Information” tab to check the 

current OS version. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Check the 

OS version 
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7.2.  SDK Updates 

The updates files of SDKs are located on: 

CD:\Napdos\wp-5000_ce50\SDK\ 

 

 

 

 

By eVC and dotnet development tools, the WinPAC SDK installation is divided into 

the following two parts: 

i. WinPAC SDK updates for dotnet (Please refer to section 6.2.1) 

ii. WinPAC SDK updates for eMbedded Visual C++ (Please refer to section 6.2.2) 

 

 

CD: \Napdos 

wp-5000_ce50 

SDK 

IO_Modules 

Modbus 

NAPOPC_CE5  

WinconSDK 

WinPacNet 

WinpacSDK 
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7.2.1.  WinPAC SDK updates for C# or VB.net 

To determine the SDK version that is compatibly running on the WinPAC, you can 

read the “Release Note” which is located under each SDK folder, these files provides 

important updated information for what we fixed and added. 

Step 1: Get the latest version of the C# or VB.net components 

The latest version of the C# or VB.net components can be obtained from:  

ftp://ftp.icpdas.com/pub/cd/WinPAC/napdos/wp-5000_ce50/sdk/WinPACNet/ 

Step 2: Copy the latest version of DLL to Host PC and WinPAC 

The DLL files on Host PC are located at anywhere only the solution can reference it. 

The DLL files on WinPAC are located at the same directory as the .exe file. 
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7.2.2.  WinPAC SDK updates for eVC++ 

To determine the SDK version that is compatibly running on the WinPAC, you can 

read the “Release Note” which is located under each SDK folder, these files provides 

important updated information for what we fixed and added. 

Step 1: Get the latest version of the eVC++ components 

The latest version of the eVC++ components can be obtained from:  

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/sdk/winpacsdk/ 

Step 2: Copy the latest version of header files and libraries to Host PC 

The header files are located at:  

C:\Program Files\Windows CE Tools\wce500\PAC270\Icpdas\Include\ARMV4I\ 

The libraries are located at:  

C:\Program Files\Windows CE Tools\wce500\PAC270\Icpdas\Lib\ARMV4I\ 

Step 3: Copy the latest version of DLL files to WinPAC 

The DLL files are located at:  

\System_Disk\ICPDAS\System 

 

 

 

 

 

 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/sdk/winpacsdk/
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Appendix A. Tips-How to 

Here we will guide you through some very useful tips to customize your 

WinPAC-5000 

 

There are more FAQ documents on 

ftp://ftp.icpdas.com.tw/pub/cd/winpac/napdos/wp-8x4x_ce50/document/faq/faq

_index.htm. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ftp://ftp.icpdas.com.tw/pub/cd/winpac/napdos/wp-8x4x_ce50/document/faq/faq_index.htm
ftp://ftp.icpdas.com.tw/pub/cd/winpac/napdos/wp-8x4x_ce50/document/faq/faq_index.htm
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A.1. How to add a User Account 

To establish a new telnet and FTP account, please perform the following steps: 

Step 1: Run the WinPAC Utility 

 

 

 

 

 

 

Step 2: On the Login tab of the FTP Setting tab, type the user name and 

password, and then press Add button 

 

 

1. Type the User name and Password 

2 
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Step 3: The user has been added to the allowed under the remote login and 

included in the following list, and then press setting button 

 

Step 4: Press OK to store the settings 
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A.1.1. How to Use telnet to remote login the WinPAC from PC  

Step 1: On the PC, open a MS-DOS command prompt 

 

 

Step 2: At the command prompt, type “telnet (IP address)” 

 

 

 

 

 

 

 

 

 

 

2. Type “cmd” 

1 

3 
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Step 3: The connection has been set up, and then type the name and 

password 

 

Step 4: The remote login has been completed 
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A.1.2. How to remove the user from the login list  

Step 1: Click a user from the list which you want to remove 

 

Step 2: The user will display in the field, and then press Delete to delete the 

user from the login list 

1. The user will display in the field 

2 
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A.2. How to online debug WinPAC 

Debugging is a process that you use to find and resolve errors, or bugs, in a 

program. 

 

 

A.2.1. Debug WinPAC programs in EVC++ 

Step 1: On the Tools menu, click Configure Platform Manager… 
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Step 2: On the Windows CE Platform Manager Configuration dialog, click 

Properties… 

 

Step 3: On the Device Properties dialog, click Configure… 
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Step 4: On the TCP/IP Transport Configuration dialog, select Fixed port check 

box, and then click the OK 

 

Step 5: On the Windows CE Platform Manager Configuration dialog, click Test 
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Step 6: The Manual Server - Action dialog will appear displaying a command 

line, before click OK to close dialog, turn to the WinPAC controller side 

to do the next two-steps 

 

Step 7: On the WinPAC, select the    menu, and then click Run…  
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Step 8: On the Run dialog, type the command which displays in step 6 and 

then click OK 

 

Step 9: Return to the Host PC side, and click OK on the Manual Server – Action 

dialog 
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Step 10: On the Testing Device Connection dialog, click OK 

 

 

Step 11: On the Device Properties dialog, click OK 
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Step 12: On the Windows CE platform or device to configure dialog, click OK 

 

Step 13: On the Build menu, point to Start Debug, and then click Go 
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Step 14: The Manual Server - Action dialog will appear displaying a command 

line, before click OK to close dialog, turn to the WinPAC controller side 

to do the next two-steps  

 

Step 15: On the Microsoft eMbedded Visual C++ dialog, click OK 
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Step 16: Connection established. Then you can debug on line. 

 

Tips & Warnings 

If you want to quit the debugger and return to editing, you can 

click the  “Stop Debugging “button from “Debug” menu 
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A.2.2. Debug WinPAC programs in Visual Studio 2005/2008 

Debugging in Visual Studio 2005/2008 are provided by WinPAC OS image V 1.3.0.4 

or later. 

 

Step 1: Make sure the following file are listed with the matching version 

numbers 

 

Path File 

C:\Program Files\Common Files\Microsoft 

Shared\CoreCon\1.0\Bin 

1. ActiveSyncBootstrap.dll 

2. ConMan2.dll 

3. ConManPS.dll 

4. DesktopDMA.dll 

5. eDbgTL.dll 

6. TcpConnectionC.dll 

C:\Program Files\Common Files\Microsoft 

Shared\CoreCon\1.0\Bin\1033 

conmanui.dll 

C:\Program Files\Common Files\Microsoft 

Shared\CoreCon\1.0\Target\wce400\armv4i 

1. DeviceDMA.dll 

2. eDbgTL.dll 

3. TcpConnectionA.dll 

4. clientshutdown.exe 

5. CMAccept.exe 

6. ConmanClient2.exe 

 

 

 

 

 

Step 2: If the version matches correctly and the entire file are there, copy the 
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following files to WinPAC:\ System_Disk\ICPDAS\System folder 

 

 Clientshutdown.exe 

 ConmanClient2.exe 

 CMaccept.exe 

 eDbgTL.dll 

 TcpConnectionA.dll 

 

Step 3: On the Project menu, click [Project Name] Properties…” 
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Step 4: On the SystemInfo* tab, unselect Deploy the latest version of the .NET 

compact Framework (including Service Packs) check box 

 

Step 5: On the Tools menu, click Options… 
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Step 6: On the Options dialog, select PAC 270 from the Show devices platform 

list, and then click Properties… 

 

Step 7: On the PAC50- ARMV4:ARMV4I_Release Properties dialog, click 

Configure… 
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Step 8: On the Configure TCP/IP Transport dialog, select the Use specific IP 

address option and type the IP address of WinPAC, and then click OK 

 

 

 

 

 

 

 

 

 

 

Step 9: On the PAC50- ARMV4:ARMV4I_Release Properties dialog, click OK 
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Step 10: On the Options dialog, click OK 

 

Step 11: On the WinPAC, run the CommanClient2 and the CMAccept.exe 

applications which is located at: \System_Disk\ICPDAS\System 
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Step 12: On the Tools menu, click Connect to Device… 

 

Step 13: On the Connect to Device dialog, select PAC 270 from Platform list 

and then click Connect 
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Step 14: On the Tools menu, click Connect to Device… 

 

Step 15: Connection established. Then you can debug on line 

 

 

 

FAQ: 

If the connection fails shown as follow, return to step 11 to do the action below 
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Open the command prompt, run the 

“CommanClient2.exe/transport:tcpconnectiona.dll/property:port=5000/id:Con” 

at: \System_Disk\ICPDAS\System, and then run the “CMAccept.exe” 
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A.3. How to use the printer 

WinPAC have ability to access the printer, you can connect to the printer via 

Ethernet network or USB. 

 

Tips & Warnings 

WinPAC only supports HP Laser Jet Printers which support 

PCL6 driver. The following printer support is released by HP 

● HP LaserJet 4000 series/HP LaserJet 4100 series 

● HP LaserJet 2100 series/HP LaserJet 2200 series 

● HP LaserJet 1200 

● HP LaserJet 3200/HP LaserJet 3300 

● HP LaserJet 4200 series/HP LaserJet 4300 series 

● HP LaserJet 5000 series/HP LaserJet 5100 series 

● HP LaserJet 8000 series 

● HP LaserJet 9000 series printers 

If you need the latest support of HP PCL6 printer, you can refer 

to following link 

http://h20000.www2.hp.com/bizsupport/TechSupport/Document.

jsp?objectID=bpl04568 

 

http://h20000.www2.hp.com/bizsupport/TechSupport/Document.jsp?objectID=bpl04568
http://h20000.www2.hp.com/bizsupport/TechSupport/Document.jsp?objectID=bpl04568
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A.3.1. How to use network printer 

To use a shared network printer, please perform the following steps: 

Step 1: On the Host PC, check the name of the Host PC and the shared printer  
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Step 2: On the WinPAC, open a WordPad format file 

 

Step 3: Set up the printer 

1. Printer: PCL Laser 

2. Port: Network 

3. Net Path: \\ServerName\PrinterName 

The “ServerName” is your PC‟s name or 

IP. 

The “PrinterName” is your printer‟s     

shared name of your PC 

4. Paper Size: Select the paper size 

 

 

file://ServerName/PrinterName
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A.3.2. How to use printer via USB 

To use a shared network printer via USB, please perform the following steps: 

 

Step 1: On the WinPAC, open a WordPad format file 

 

Step 2: Set up the printer 

1. Printer: Hewlett-Packard LaserJet 

2. Port: LPT1 

3. Paper Size: Select the paper size 
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A.4. How to use services tool 

The services tool can help you turn on, turn off and monitor the WinCE services. 

Step 1: Open a MS-DOS command prompt 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Type “cmd” 
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Step 2: List all services 

[Syntax] services list 

Step 3: Type the commands to configure service  

[Syntax] services stop <services name> 

For example, turn on the “FTP” service: 

services stop FTP0: 
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Tips & Warnings 

For more information about using services tool, you just type 

“services help” 
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A.5. How to use ActiveSync through USB port 

ActiveSync helps you to synchronize the files on your host PC with the WinPAC. 

Step 1: On the PC, install the Microsoft ActiveSync software 

The Microsoft Active Sync software can be obtained from Microsoft website. 

 

Step 2: Run the Microsoft ActiveSync 

You can run Microsoft Active Sync from the Start menu 
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Step 3: On the File menu, click Connection Settings… 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4: Make sure the Allow USB connections are selected, and then click 

Connect… 
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Step 5: Click Next to get connected 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 6: Wait a while until the connection is established 

After the connection is established, the color of the ActiveSync icon will change to 

green. 

 

Disconnected – Black & 

Write 

 

 

Connected - Green 
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Step 7: Click Yes, and then click Next to set up a partnership 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 8: Select the type of information you want to synchronize, and then click 

Settings… 
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Step 9: Click Finish to complete the setup 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 10: Click Sync to synchronize the information 
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Example: Synchronize a file between the PC and WinPAC-5000 

Step 1: Follow the above-mentioned procedures to synchronize a file folder, 

and then double-click the Files 

 

 

 

 

 

 

 

 

 

 

Step 2: Under the Synchronized files, click Add… to select the synchronized 

files or add the file to the synchronization folder, and then click OK 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The path of the 

synchronization 

folder. 
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Step 3: Check the synchronization status 

After clicking OK, the synchronization will be performed. 

 

The synchronization folder on PC 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The synchronization folder on WinPAC-5000 
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A.6. How to automatically synchronize the 
WinPAC clock with an Internet Time Server 

 

Step 1: Run the WinPAC Utility 

 

 

 

 

 

 

 

 

Step 2: On the System Settings tab, press Configure 
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Step 3: Select the domain name 

in the Server drop down 

list, and then enter a 

value in the Autoupdate 

Frequency field 

Step 4: Check the 

“Automatically 

synchronize with an 

internet time server” 

check box 

Step 5: On the File menu, click Save 

and Reboot 

Step 6: The WinPAC will automatically 

synchronize with an internet 

time server regularly 

 

Step 7: Press Update Now to 

synchronize WinPAC 

clock immediately. 
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Appendix B. XW-board Modules 

The XW-board series are for uPAC-5000, 

LP-5000, and WP-5000 series. One PAC can 

only plug only one XW-board. The XW-board 

series have following common specification: 

● DI channel is dry contact, sink type.  

● DO channel is open collector, sink type. 

DI, DO Expansion 

Model DI DO Isolation 

XW107 
8 8 

- 

XW107i 3750 Vrms 

XW110i 16 - 3750 Vrms 

AI, AO, DI, DO Expansion 

Model 
AI (12-bit) AO (12-bit) 

DI DO 
Ch Range Ch Range 

XW304 6 +/- 5V 1 +/- 5V 4 4 

XW310 
4 

+/- 10V 
2 

+/- 10V 
3 3 

XW310C 0~20 mA 0~20 mA 

RS-232/422/485, DI, DO Boards 

Model 
Serial Port 

DI DO Isolation 
Type Ch Wire 

XW506 RS-232 6 3-wire - - 
- 

XW507 RS-422/RS-485 1 4/2-wire 5 5 

XW508 RS-232 8 3-wire - - - 

XW509 RS-232 2 5-wire 4 4 - 

XW511i RS-485 4 2-wire - - 2500 Vrms 

XW514 RS-485 8 2-wire - - - 

For more detailed information about these support modules, please refer to 

http://www.icpdas.com.tw/product/solutions/pac/upac/xw-board_selection.html 

http://www.icpdas.com.tw/product/solutions/pac/upac/xw-board_selection.html
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Appendix C. Revision History 

Revision Date Description 

1.0.1 August 2010 Initial issue 

1.0.2 December 2010 1. Added information about using backup 

utility to back up the settings and files in 

section 2.5. 

2. Added information about a caution 

about using System_Disk in section 

2.6. 

3. Added information on how to add a user 

account in section A.1. 

1.0.3 January 2012 1. Modified information about XW-board 

supported in section 3.6.2 and 

appendix B. 

2. Modified information about the OS 

updates in section 6.1.1 and section 

6.1.2. 

1.0.4 August 2012 1. WP-5441 changed the Model number to 

WP-5141-OD. 

2. Added information about COM1, COM2 

and COM3 in section 1.4. 

3. Added information about how to use the 

printer in appendix A.3. 

1.0.5 October 2012 Modified information about WinPAC 

Platform SDKs in chapter 4. 

1.0.6 September 2013 1. Update WinPAC utility information in 

section 3.6. 

2. Added Understanding the PACSDK and 

PACSDK reference in section 4.2. 

3. Added I/O Modules and SDK Selection 

in section 6. 

1.0.7 January 2014 Added information about battery. 
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Revision Date Description 

1.0.8 June 2018 1. Added information about 

WP-5151/WP-5151-OD in section 1.1, 

1.1.2, 1.3, 1.4, 1.5, 2 and 2.1. 

2. Deleted a caution about using 

System_Disk in section 

3. Added information about the location of 

the PACNET.dll file in section 4.3.2 and 

4.3.3. 

 


	Table of Contents
	1.  Introduction
	1.1.  WinPAC-5000 Family
	1.1.1.  WinPAC-5000 Naming Convention
	1.1.2.  WinPAC-5000 Comparison

	1.2.  Features
	1.3.  Specifications
	1.4.  Overview
	1.5.  Dimension
	1.6.  Companion CD

	2.  Getting Started
	2.1.  Mounting the Hardware
	2.2.  Configuring the Boot Mode
	2.3.  Changing the Language of the User Interface
	2.4.  Using WinPAC Utility to Configure WinPAC Basic Functionality
	2.5.  Using Backup Utility to Back up the Settings and Files

	3.  Tools and Tasks
	3.1.  Backup Utility
	3.2.  Dconmcnfg
	3.3.  Napopc_ce5
	3.4.  SendToCOM
	3.5.  VCEP
	3.6.  WinPAC_Utility
	3.6.1.  Menu Bar
	3.6.2.  Property Tabs


	4.  Your First Program
	4.1.  Preparing the Development Tools
	4.2.  Installing WinPAC-5000 SDK
	4.3.  Your First Program in C#
	4.3.1.  Creating a New Project
	4.3.2.  Adding the WinPAC-5000 Reference
	4.3.3.  Adding the Control to the Form
	4.3.4.  Adding the Event Handling to the Control
	4.3.5.  Upload the Application to WinPAC-5000
	4.3.6.  Executing the Application on WinPAC-5000

	4.4.  Your First Program in VB.net
	4.4.1.  Creating a New Project
	4.4.2.  Adding the WinPAC-5000 Reference
	4.4.3.  Adding the Control to the Form
	4.4.4.  Adding the Event Handling to the Control
	4.4.5.  Upload the Application to WinPAC-5000
	4.4.6.  Executing the Application on WinPAC-5000

	4.5.  Your First Program in eMbedded Visual C++
	4.5.1.  Creating a Forms-Based Project
	4.5.2.  Configuring the Platform
	4.5.3.  Specifying the Path of the WinPAC-5000 Reference
	4.5.4.  Adding the Control to the Form
	4.5.5.  Adding the Event Handling to the Control
	4.5.6.  Upload the Application to WinPAC-5000
	4.5.7.  Executing the Application on WinPAC-5000


	5.  APIs and Demo Programs
	5.1.  Demo Programs with C#
	5.1.1.  C# Demo Programs for WinPAC Standard API
	5.1.2.  C# Demo Programs for PAC I/O API

	5.2.  Demo Programs with eVC++
	5.2.1.  eVC++ Demo Programs for WinPAC Standard API
	5.2.2.  eVC++ Demo Programs for PAC I/O API


	6.  I/O Modules and SDK Selection
	7.  WinPAC-5000 Updates
	7.1.  OS Updates
	7.1.1.  OS Updates Using Installation Package File
	7.1.2.  OS Updates Using Eshell via Ethernet

	7.2.  SDK Updates
	7.2.1.  WinPAC SDK updates for C# or VB.net
	7.2.2.  WinPAC SDK updates for eVC++


	Appendix A. Tips-How to
	A.1. How to add a User Account
	A.1.1. How to Use telnet to remote login the WinPAC from PC
	A.1.2. How to remove the user from the login list

	A.2. How to online debug WinPAC
	A.2.1. Debug WinPAC programs in EVC++
	A.2.2. Debug WinPAC programs in Visual Studio 2005/2008

	A.3. How to use the printer
	A.3.1. How to use network printer
	A.3.2. How to use printer via USB

	A.4. How to use services tool
	A.5. How to use ActiveSync through USB port
	A.6. How to automatically synchronize the WinPAC clock with an Internet Time Server

	Appendix B. XW-board Modules
	Appendix C. Revision History

